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Chapter 1
Introduction
The Basics
Ad-hoc Dashboard is a Web application that enables the building and navigation of Business Intelligence
dashboards. A dashboard consists of a number of cards, each card contains different types of views,
and each view presents data differently. By dragging and dropping the views on to the dashboard, you
can customise your dashboard and add various components, without needing to write any scripts.
Behind the scenes, each dashboard reads data from a Universe, which can be defined using the Universe
Designer and which collects a set of data tables together. A data administrator, familiar with the database
structure will usually perform this step and then publish a dashboard template which links to the
Universe. Once this template is published, you can use it to construct your own ad-hoc dashboards
without worrying about database access rights and how the tables are joined together.
Ad-hoc Dashboard runs as a service and supports multiple domains. Behind the scenes, the Ambience
system runs multiple engines to process the data in parallel, and uses a load-balancing scheduler to
share the work. Ambience allows you to add additional engines to the system to handle higher volume.
Each Ad-hoc Dashboard engine can be shared among multiple domains, and each domain can have
multiple Ad-hoc Dashboard engines.
Ad-hoc Dashboard provides the following advantages to enhance business operations:
•

Ease of use: From anywhere at any time, you can view crucial information at a glance. To access
Ad-hoc Dashboard, all you need are a computer or mobile device and an Internet connection.

•

Interaction: Ad-hoc Dashboard brings you direct interactions with crucial information. It responds
to all your requests in a fast and accurate manner.

•

Customisation: Ad-hoc Dashboard displays exactly what you need as a result of customisation.
Customised dashboards can be easily saved and opened in the Elixir Ambience Web Console,
without repeated efforts of rebuilding. Dashboards are able to present data with the appropriate
level of detail, according to the set of customized views. Views can be rendered into Microsoft
Excel, Microsoft Word, HTML or Portable Document Format (PDF).

•

Visualisation: Ad-hoc Dashboard visualises information using a comprehensive set of components,
including button, image, HTML, parameter, chart, report, and table. These components present
information in an intuitive manner, making it easier and faster for you to master the information.

•

Scalability: Ad-hoc Dashboard enables many users to access dashboards simultaneously and
receive quick responses to multiple requests for information.

•

Flexibility: Providing complete flexibility, Ad-hoc Dashboard enables you to create and manage
dashboards based on your own requirements, as well as decide which part of information matters
to you. It can either run as a standalone Web application, or be integrated into the existing system
of an enterprise.

The Building Blocks
The building blocks of each dashboard are:
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•

Cards: Cards are the containers or screens on which you drag and drop the views to build your
Business Intelligence solutions. Each card contains a group of related views working in unison to
display the information you want to see.
For more information, see Chapter 4, Operations on Cards.

•

Views: Views provide a customised view of data. Using views, you can customise the information
that you want to see, facilitating easy understanding of critical business parameters. For example,
you can create a view to only show you the sales and revenue information for a particular quarter.
You use the components from the Components tab to create views on cards.
For more information, see Chapter 5, Operations on Views and Chapter 7, Customizing Views.

•

Actions: Actions specify what to do from either single or double clicking a view. For example,
data from a particular view can be saved as a PDF file when you double click the view.
For more information, see Chapter 6, Using Actions.
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Chapter 2
Using Adhoc Dashboard
Dashboard Walkthrough - Creating Your
Dashboard
This section walks you through creating an example dashboard step-by-step. The example uses two
cards, two grids, a bar chart component, a table component and two button components.
The dashboard displays the number of cars traded in for each year for the selected US States.
The first card contains the grids, the bar chart and a button to navigate to the second card.
The second card contains the table and a button to navigate to the first card.
The first grid contains the four Regions in the US. Click a Region from the first grid to display the
States in that Region on the second grid.
Click a State from the second grid to display the number of used cars that were traded in for new ones,
each year, for the selected States as a bar chart.
Click a row from the the bar chart and click Submit. The second card is displayed with a table containing
the details of the selected row. Click Submit from the second card, to navigate back to the first card.
The final dashboard looks as shown in Figure 2.25, “Final Dashboard” and Figure 2.29, “Table Output”

Workspace refers to the card on which you drag and drop components to create your views.
To create your dashboard, perform the actions in the following sections:

Part 1 - Accessing the Adhoc Dashboard application
To login and create a new dashboard:
1.

Login to the Adhoc Dashboard application.

2.

Click Create - Ad-hoc Dashboard and then click Cars , to use the Cars universe for your
dashboard, as shown in Figure 2.1, “Create Ad-hoc Dashboard”:
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Figure 2.1. Create Ad-hoc Dashboard

3.

Select a location in the repository from the drop-down list, as shown in Figure 2.2, “Select
Repository Location”. Enter the file name and click Create.

Figure 2.2. Select Repository Location

4.

The system creates a blank dashboard and opens it in Run mode, in a new browser tab as shown
in Figure 2.3, “System Creates a Blank Dashboard”.

Figure 2.3. System Creates a Blank Dashboard

5.

To edit the dashboard, click Edit. The dashboard changes to Edit mode as shown in Figure 2.4,
“System Dashboard in Edit Mode”.
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Figure 2.4. System Dashboard in Edit Mode

Part 2 - Setting up the Grid Selection
1.

Click the Components tab. Drag and drop the Grid component to the workspace.
Grid view shows unique values from a particular column in the universe. A grid is a selection
mechanism to narrow down the range of values, and is used to view a summary of the data.
For more information on the Grid component, see the section called “Grid”.

2.

Right-click the Grid component in the workspace and select Properties.

3.

Navigate to the data tab and set the Universe table to US Region as shown in Figure 2.6, “Set
the Data Properties of the First Grid”:
Click the
icon. Select the Region and Region ID columns as shown in Figure 2.5, “Select
the Region Table”.

Figure 2.5. Select the Region Table
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You can select multiple columns across tables as required. The system is smart to figure out the
relationships between the entities and present you the data seamlessly.
This populates the grid with the four US regions.

Figure 2.6. Set the Data Properties of the First Grid

4.

Navigate to the type tab and set the Column to Region as shown in Figure 2.7, “Set the Type
of the First Grid”.
The Count and Direction properties define the layout of the grid.
The Count value indicates that the grid is to have one row of data. The grid is set as a single
selection grid - only one value from the grid can be selected at a time.

Figure 2.7. Set the Type of the First Grid
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5.

Navigate to the selection tab and set the Type to first as shown in Figure 2.8, “Set the Selection
of the First Grid”.
This indicates that the first value on the grid is selected by default.

Figure 2.8. Set the Selection of the First Grid

6.

Click Apply to apply the changes.

7.

Drag and drop another Grid component to the workspace, and align it below the first grid.

8.

Right-click the second Grid component in the workspace and select Properties.

9.

Navigate to the data tab and set the Universe table to US State as shown in Figure 2.10, “Set
the Data Properties of the Second Grid”:
Click the
icon. Select the State and Region ID columns as shown in Figure 2.9, “Select the
State Table”.

Figure 2.9. Select the State Table
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This specifies that the US States should be displayed on the grid.

Figure 2.10. Set the Data Properties of the Second Grid

10. Navigate to the type tab and set the Column to State as shown in Figure 2.11, “Set the Type
of the Second Grid”.
The Count and Direction properties define the layout of the grid.
Here, you also set the Count as 2 - indicating that the grid is to have two rows of data, and the
direction as Down, which specifies that the rows are to be one below the other.
In addition, the grid is set as Multiple Select. This allows multiple selection of values from the
grid.
Set the sort order to ascending. This sorts the State codes in alphabetical order for display.
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Figure 2.11. Set the Type of the Second Grid

11. Navigate to the selection tab and set the Type to first as shown in Figure 2.12, “Set the Selection
of the Second Grid”.
This indicates that the first value is selected and highlighted by default.

Figure 2.12. Set the Selection of the Second Grid

12. Navigate to the filters tab and set the properties as follows:
•

Name: US Region ID

•

Filter: in-dataset

•

Condition: Click the
icon and set the condition as shown in Figure 2.13, “Set the Region
Filter”. Click OK to save the changes.
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Figure 2.13. Set the Region Filter

Here, you select to filter values based on the common column RegionID, that is present in the
first grid (the Region grid), that is named as View-1 on your dashboard.
The values are then filtered, and only the States that correspond to the Region selected in the first
grid, are displayed in this second grid.
The filter after selection, is shown in Figure 2.14, “The Selected Region Filter”

Figure 2.14. The Selected Region Filter

13. Click Apply to apply the changes.
14. Save your dashboard as mentioned in the section called “Saving Your Dashboard”.
15. Click Run to navigate to the Run mode and check that your grid selection works. Select the
Regions from the first grid and watch the second grid automatically display only those states that
correspond to the selected region from the first grid.
Here are some screen shots that show you how the grid selection works:
Midwest:

Figure 2.15. Midwest-Region

Northeast:
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Figure 2.16. Northeast-Region

South:

Figure 2.17. South-Region

West:

Figure 2.18. West-Region

Part 3 - Viewing the Data
In Part 1, you have set up the grid selection and ensured that the States corresponding to the selected
Region are displayed.
In this section, you set up the bar chart to view the data for the selected States.
1.

Drag the Bar Chart component on to the workspace and position it below the second grid i.e. the States grid.

2.

Right-click the Bar Chart component in the workspace and select Properties.
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3.

Navigate to the Data tab and select the invoice_id and trade_in_year columns from the
Cars table. Also select the State column from the US.State table. This is shown in
Figure 2.19, “Set the Data Properties of the Bar Chart”

Figure 2.19. Set the Data Properties of the Bar Chart

4.

Navigate to the ElxBar tab and set the Key to trade_in_year. The years are plotted on the
Y-axis.
In the Values table, set the Column to invoice_id and the Operation to Count.
The total number of traded-in invoices for each year is plotted on the X-axis. This denotes the
number of cars traded-in for the year.
This is shown in Figure 2.20, “Set the ElxBar Properties of the Bar Chart”

Figure 2.20. Set the ElxBar Properties of the Bar Chart

5.

From the ElxBar tab, set the Background fill colour and the border color as shown in Figure 2.21,
“Set the Background Color of the Bar Chart”
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Figure 2.21. Set the Background Color of the Bar Chart

6.

From the ElxBar tab, set the Chart Title, the Y-Axis Title (Subtitle West), and the position of
the Legend to West as shown in Figure 2.22, “Set the Title of the Bar Chart”

Figure 2.22. Set the Title of the Bar Chart

7.

Navigate to the Filters tab and set the properties as follows:
•

Name: US State

•

Filter: in-dataset
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•

Condition: Click the
icon and set the condition as shown in Figure 2.23, “Set the State
Filter”. Click OK to save the changes.

Figure 2.23. Set the State Filter

Here, you select to filter values based on State, that is present in the second grid (the State grid),
that is named as View-2 on your dashboard.
The values are then filtered, and only the data for the States selected in the second grid, are
displayed in this bar chart.
This filter after selection is shown in Figure 2.24, “Set the Filter Properties of the Bar Chart”

Figure 2.24. Set the Filter Properties of the Bar Chart

8.

Click Apply to apply the changes.

9.

Save your dashboard as mentioned in the section called “Saving Your Dashboard”.

10. Click Run to change the dashboard mode to Run.
11. Click Reset to rest the dashboard to the default state.
12. Select a region and state and view the data as shown in Figure 2.25, “Final Dashboard”,
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Figure 2.25. Final Dashboard

The chart shows the number of old cars that were traded in for new cars each year.

Part 4 - Drilling Down Into the Data
1.

Click the Add Cards icon
card2 is added.

from the cards explorer, to add a new card. A new card named

2.

Navigate to the second card and drag and drop a Table component on to the workspace.

3.

Right click the Table component and select Properties.

4.

Navigate to the data tab and select all the columns from the Cars table as shown in Figure 2.26,
“Selecting the Data Columns for the Table”.
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Figure 2.26. Selecting the Data Columns for the Table

5.

Navigate to the type tab and select the columns to be displayed in the table. Also, set the Page
Size as desired.
Page Size indicates the number of rows to display in one page of the table.

Figure 2.27. Selecting the Columns to be Displayed in the Table

For more information on Table, see the section called “Table”.
6.

Navigate to the filters tab and set the properties as follows:
•

Name: invoice_id

•

Filter: in-dataset

•

Condition: Click the
icon and set the condition as shown in Figure 2.28, “Set the Invoice
ID Filter”. Click OK to save the changes.
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Figure 2.28. Set the Invoice ID Filter

Here, you select to filter values based on invoice_id, that is present in the Bar Chart, that is named
as View-3 on your dashboard.
7.

Click Apply to apply the changes. The final table is similar to the following:

Figure 2.29. Table Output

8.

Drag and drop a Button component on to the workspace of Card2.

9.

Right-click the Button component in the workspace and select Add Action.

10. Select the Event as Any, the Action as Show Card and the Card as Card1
11. Ensure that the Enabled checkbox is selected.
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Figure 2.30. Button to Show Card 1

12. Click OK to save the action. The completed Card 2 with the Submit button is as follows:

Figure 2.31. Completed Card 2

Clicking this button (either a single click or a double click) will navigate back to the first card.
13. Navigate to Card 1 using the card explorer.
14. Drag and drop a Button component on to Card1.
15. Right-click the Button component in the workspace and select Add Action.
16. Select the Event as Any, the Action as Show Card and the Card as Card2
17. Ensure that the Enabled checkbox is selected.
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Figure 2.32. Button to Show Card 2

18. Click OK to save the action. The completed Card 1 with the Submit button looks as follows:

Figure 2.33. Completed Card 1

Clicking this button (either a single click or a double click) will navigate to the second card.
Congratulations. Your dashboard is now created.

Saving Your Dashboard
To save your dashboard, do one of the following steps:
1.

Click Save when the dashboard is in the Edit mode as shown in Figure 2.34, “Save Your
Dashboard in Edit Mode”.
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Figure 2.34. Save Your Dashboard in Edit Mode

The changes you made to the dashboard will all be saved into the current dashboard file.
2.

i.

Click Run to turn the dashboard to the Run mode.

ii.

Click Save As... and select a location in the repository and enter a new file name, or choose
to rewrite the original dashboard file, as shown in Figure 2.35, “Save Your Dashboard in
Run Mode”.

Figure 2.35. Save Your Dashboard in Run Mode

If you forget to save the dashboard and close it, a message will display next time
you try to open the dashboard, asking if you want to load last backup or load last
save.
If you want to continue editing the dashboard and keep the unsaved changes, select
Load Last Backup.
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If you want to discard the unsaved edits and return to the dashboard you have most
recently saved, select Load Last Save.
3.

If you accidentally overwrite your changes, you can restore one of the previous versions of the
file:
a.

Click the Repository tab.

Figure 2.36. Repository Tab

b.

Navigate to the folder where your file is located, and click the file name.

c.

Click Versions from the right pane.

Figure 2.37. File Versions

d.

The list of versions of the file is displayed. Select the version to be restored and click Revert
to revert to the selected version of the file.
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Figure 2.38. Revert to a Version of the File

Previewing Your Dashboard
To preview your dashboard, click Run. The output of the Dashboard displays in your browser.

Publishing Your Dashboard
Publishing creates a snapshot of the dashboard. The dashboard cannot be edited further.
People without editing rights can still view and operate your dashboard.
The published dashboard always starts in the last state in which it was published.
Resetting a published dashboard, resets it to the state it was when published.
To publish your Ad-hoc Dashboard:
1.

Click Run to turn the dashboard to the Run mode.

2.

Click Publish. The Publish As window opens, allowing you to select a location in the
repository and enter the new file name, as shown in Figure 2.39, “Publish Your Dashboard”.
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Figure 2.39. Publish Your Dashboard

By default, the new file name will end with .dashboard-saved to differentiate it
from the original editable dashboard.
If you launch the published dashboard later by opening it from Ambience Web Interface
> Repository, it displays as a read-only report in browser.
Though the published dashboard is not editable, you have the option to reset it to the
last saved state or save it as another copy.

Deleting Your Dashboard
Optionally, if you have multiple copies of your dashboard and want to tidy up, or no longer need a
particular dashboard, you can delete it.
To delete your dashboard:
1.

Open Ambience Web Interface > Repository.

2.

Locate the Ad-hoc Dashboard file in the repository.

3.

Click the file and select Delete from the right pane, as shown in Figure 2.40, “Delete Your
Dashboard”.
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Figure 2.40. Delete Your Dashboard

24

Chapter 3
Setting
up
Properties

the

Dashboard

To set the dashboard properties click the
icon. Set the properties from the screen that is displayed
as shown in Figure 3.1, “Set Dashboard Properties”.

Figure 3.1. Set Dashboard Properties

Use Table 3.1, “Dashboard Properties” as a guide to set the dashboard properties:
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Table 3.1. Dashboard Properties
Property

Value

Universe

Universe that provides the data for the dashboard

Initial Card

A new or an existing card that is set as the first card.

Card Transitions

Denotes the transition effect.
•

None: The card transition will happen without any effects.

•

Fade: A card will fade out during transition.

•

Slide Left: A card will slide to the left during transition.

•

Slide Right: A card will slide to the right during transition.

•

Slide Left and Right: If the destination card is before the origin card,
then the destination card appears from the left. If the destination card
is after the origin card, then the destination card appears from the right.

•

Slide Up: A card will slide to the top during transition.

•

Slide Down: A card will slide to the bottom during transition.

•

Slide Up and Down: If the destination card is before the origin card,
then the destination card appears from the upper side. If the destination
card is after the origin card, then the destination card appears from the
lower side.

Enable Themes

Enable this to permit users to set their own themes for the dashboard.

Enable Annotations

Allows you to enable or disable the button to add annotations to the
dashboard entries.

Width

Width in pixels

Height

Height in pixels

Position

•

Left: The dashboard will display on the left of the workspace.

•

Centre: The dashboard will display in the centre of the workspace.

•

Right: The dashboard will display on the right side of the workspace.

Background

RGB color of the background

Background Image

Select and upload the background image.

Image Repeat (for the
background image)

•

None: The image will display at the upper left corner of the background.

•

X and Y: The image will display on the whole background.

•

X: The image will display along the X axis of the background.

•

Y: The image will display along the Y axis of the background.

Dashboard

RGB color of the dashboard

Dashboard Image

Select and upload the dashboard image.
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Property

Value

Image Repeat (for the
dashboard image)

•

None: The image will display at the upper left corner of the background.

•

X and Y: The image will display on the whole background.

•

X: The image will display along the X axis of the background.

•

Y: The image will display along the Y axis of the background.
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Operations on Cards
Adding a Card
To add a card:
1.

Open a dashboard and click Edit on the top panel. The dashboard turns into the Edit mode.

2.

Click the Cards tab on the left panel. The Cards explorer displays.

3.
4.

Click the Add Card icon

. A slide window displays.

Enter the card name. Select a card master, if desired.

A master is a card to be rendered behind the current card. Therefore anything placed on
the master will be accessible from the current card.
Its purpose is to provide reuse of a set of views that can then be shared by other cards.
You can create a card with a logo, navigation etc. and set it as the card master for other
cards.
It is possible to have a number of master cards being used. For example if we have cards
A, B and C, then C can be the master of B, and B can be the master of A. Therefore in
viewing card A you will see the all views on card B and C at the same time.
5.

Click the OK icon

.

The card is successfully created.

Using a Card Master
A Card Master provides reuse of a set of views that can then be shared by other cards. You can create
a card with a logo, navigation etc. and set it as the Card Master for other cards.
The following example will make it clear.
1.

Create a new dashboard, and drag and drop a Label component on to the default card (Card 1).

2.

Right click the Label and select Properties.

3.

Navigate to the type tab and enter some text for the label - for example,
Example.
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Figure 4.1. Label Properties

4.

Click Apply to save the changes.

5.

From the Cards explorer, add a new card - Card 2 and set the Card Master as Card 1.

Figure 4.2. Set Card 1 as Master for Card 2

6.

Click the OK icon

7.

Notice how the label from card 1 (Card Master) is displayed in Card 2.

.

Figure 4.3. Label in Card 1
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Figure 4.4. Card 1 Output in Card 2

Card Master - Cumulative Example
If you make Card 1 as the Card Master for Card 2, and make Card 2 as the Card Master for Card 3,
then content from both Card 1 and Card 2 will be displayed in Card 3.
The following example illustrates this concept.
1.

Continuing the example from the section called “Using a Card Master”, drag and drop a Grid
component to Card 2.

2.

Add a new card (Card 3) and make Card 2 as the Card Master for Card 3.

Figure 4.5. Set Card 2 as Master for Card 3

3.

Notice how the Label component from Card 1 and the Grid component from Card 2 are
displayed in Card 3.

Figure 4.6. Grid in Card 2
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Figure 4.7. Card 1 and Card 2 Output in Card 3

Reordering Cards
When there are multiple cards created, you have the option to reorder them.:
1.

Open the Cards explorer, and all cards display in a list.

2.

Hover on the card to display the reorder icon .

3.

Drag the card you want to move, to the desired position.

Showing a Card
To display a hidden card, open the Cards explorer, and double-click the desired card name. The
selected card will be shown on the workspace.

Setting Card Properties
Card properties include card name and card master. To alter these values:
1.

Right-click the desired card, click Properties, and set the properties in the slide window.

2.

Click the OK icon

.

Copying a Card
You can copy the contents from a card into a new one.
1.

Open the Cards explorer, right-click the desired card and select Copy.

2.

Enter the name of the new card to inherit the original contents.

3.

Click the OK icon

.

Deleting a Card
To delete a card:
1.

Open the Cards explorer, right-click the desired card and select Delete.

2.

A confirmation message is displayed. Click the OK icon
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If you try to delete a card on the dashboard, and it has a dependent card, then a warning
dialogue is displayed, offering you the option to cancel the delete operation.
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Chapter 5
Operations on Views
Adding a View
To add a view:
1.

Open a dashboard and click Edit on the top panel. The dashboard turns into the Edit mode.

2.

Click the Cards tab on the left panel. The Cards explorer displays.

3.

Click the desired card. If necessary, add a new one.

4.

Drag and drop the desired component onto the card.

5.

Click the Components tab. Drag the desired component onto the card so that the desired view is
created. If you add more components, there will be a new view created for each component.

The view is successfully added.

Reordering Views
When there are multiple views created, you have the option to reorder them:
1.

Open the Cards explorer, and all cards display in a list.

2.

Double-click the desired card. All views under this card display.

3.

Hover on the view to display the reorder icon .

4.

Drag the view you want to move, to the desired position.

Setting View Properties
View properties include view name, component category, component type, visibility state and more.
To alter these values:
1.

Right click the desired view, and click Properties, or double click the view to display the
Properties dialogue. Set the properties of the corresponding component in the workspace.

2.

Click Apply.

Copying a View
You can copy the contents from a view into a new one.
1.

Open the Cards explorer, and double-click the desired card.

2.

Right-click the original view and select Copy to.
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3.

Fill in the name of the new view and select a card to which the view is to be copied.

4.

Click the OK icon

.

Moving a View
You can move an entire view into another card.
1.

Open the Cards explorer and double-click the desired card.

2.

Right-click the original view and select Move to.

3.

Select a card which the view is to be moved.

4.

Click the OK icon

.

Deleting a View
To delete a view:
1.

Open the Cards explorer and double-click the desired card.

2.

Right-click the desired view and select Delete.

3.

A confirmation message is displayed. Click the OK icon

If you try to delete a view on the dashboard and it has a dependent view, then a warning
dialogue is displayed, offering you the option to cancel the delete operation.
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Using Actions
Actions allow you to perform a number of different functions on the views. You can setup actions to
be activated when mouse events such as a single click or a double click are performed.
The list of actions that can be performed on the views are as shown in Table 6.1, “List of Actions”:

Figure 6.1. List of Actions
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Table 6.1. List of Actions
Action

Description

Auto Refresh View

Automatically refreshes a view based on the specified time period (in
seconds). The event is set to auto for this action.

Logout

Signs out from the Ambience Web Console. This is especially useful
in Kiosk mode where you want the user to log out after using the
dashboard.

Hide View

Hides a view.

Maximise View

The view will fill the maximum dimensions of the dashboard.

Refresh View

Reloads the specified view in the dashboard, when there are changes
in the components, actions or view properties.

Render Report

Generates the output of the view into a report template (RML format).
Specify the path and name of the RML file by clicking the

icon.

Render View (Fixed Format) Generates the output of the view into a pre-defined format, which can
be HTML, PDF, XLSX or CSV.
Render View (Formattable)

You can select the formatting options, to display the view.

Reset

Restores the view to the last saved state.

Show Card

Displays the specified card in the dashboard.

Show Hide View

Toggles the visibility of a view.

Show View

Shows a view.

Adding an Action
To add an action to a view:
1.

Open a dashboard and click Edit on the top panel. The dashboard turns into the Edit mode.

2.

Click the Components tab and drag and drop a component on the card (workspace).

3.

Click the Cards tab on the left panel. The Cards explorer displays.

4.

Click the Actions > Add icon

. A slide window displays.

5.

Select the desired view from the View drop-down list.

6.

Select either Click, Double Click or Any from the Event drop-down list. Any indicates that
the action is applicable for both Click as well as Double Click.

7.

Select an action from the Actions drop-down list, as shown in Figure 6.1, “List of Actions”.

8.

Select the Enabled checkbox.

9.

Click the OK icon

. The action properties will take effect.

Alternatively:
1.

Right click the component on the dashboard and select Add Action. The action dialogue with
the actions applicable for the component is displayed.

2.

Select an action from the Actions drop-down list and click OK to set the action.

36

Using Actions

Action Behaviour When Using Card Masters
If you are using Card Masters as described in the section called “Using a Card Master”, actions that
are defined on views in the Card Masters, are still functional in the appropriate child cards, as the Card
Master views are displayed in these child cards.

Action Example
For an example of using actions, see the section called “Part 4 - Drilling Down Into the Data”

Reordering Actions
When there are multiple actions created, you have the option to reorder them. To reorder actions:
1.

Open the Cards explorer. All the actions display on the left panel.

2.

Hover on the card to display the reorder icon .

3.

Drag the action you want to move, to the desired position.

Disabling (Stopping) an Action
To stop an action:
1.

Open the Cards explorer, and all actions display on the left panel.

2.

Right-click the action to be disabled and select the Stop checkbox.

3.

Click the OK icon

.

The action will still remain in the Actions list, but will not be activated.

Deleting an Action
While disabling an action will still keep it, deleting an action will remove it completely. To delete an
action:
1.

Open the Cards explorer to display all actions.

2.

Right-click the action to be deleted, and select Delete. A confirmation message is displayed.

3.

Click the OK icon

to confirm the deletion.

If you try to delete an action and it has a dependent view, then a warning dialogue is displayed,
offering you the option to cancel the delete operation.
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Chapter 7
Customizing Views
Introduction
The Components tab allows you to drag and drop the required View onto a dashboard card.
Customisation of the View is then carried out by changing its available properties.
To add a component:
1.

Open a dashboard and click Edit button on the top panel. The dashboard turns into the Edit
mode.

2.

Click the Cards tab on the left panel. The Cards explorer displays.

3.

Double-click the desired card where you want to place the component. The card displays on the
right panel.

4.

Click the Components tab. Select from the General, Data and Chart categories. Drag the
desired component and drop it on the right panel. A view which contains the component will be
automatically created.
Once the view is on the card, you can resize it by clicking and dragging the bottom right hand
corner. It can also be moved to a new location by clicking inside the view and dragging.

5.

Double-click the component area and set the properties. You can set the view name, visibility
state (visible or hidden), and Z Index. Z Index controls the position of a view moving behind or
in front of other views. This could be a negative number or a positive number. When all views
have a Z Index with the Auto option selected, what causes them to be behind or in front of other
views depends on the order in which the views are added to the dashboard. However, in some
cases you have to manually set the Z Index to a positive number. For example, a HTML view
that is used to present a custom menu on a master card would normally stay behind all other
views. When you activate a sub menu, this should show in front of any other views, otherwise it
may be partially hidden. Setting the Z Index to a positive value number would achieve this.
Read this chapter fully for more details on how to set each type of component.

6.

The refresh button in the preview pane on the right allows properties changes to be previewed
before applying the changes and returning to the dashboard.

Previewing a View
The Dashboard features previews of the component properties being edited. This helps you visualize
the effects of the changes you are making, before applying them to the component.
To preview the changes, click the Refresh icon

.

The following figure shows an example of the preview:
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Figure 7.1. Previewing a View

Resizing a component in the preview pane automatically displays a message asking whether to apply
the new size to the component. This is shown in the following figure:

Figure 7.2. Resizing a Preview

Select the Apply with new size? option and click Apply to resize the component.

Charts
Common Properties
This section lists the properties that are common to the Chart components.

View
The View tab lets you see the views name and type and also set the initial visibility and z-index.
The Image Server provides a static image of your view.
The Show Image Server Url option allows you to set the image height and width, and the cache
duration.
You can copy and paste this URL anywhere else (for example, in Adhoc Reports) to display the image.

Action Bar
•

Show action bar: Determines whether to display the action bar or not.

•

Title: Fill in the title.

•

Show info button: Fill in the information and customise its format. On clicking, the information
you have entered will display in a text field, guiding the user on how to proceed.
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•

Show render button: A render button will display, which allows you to render into the desired
output format, including HTML, PDF, XLSX and CSV. You can choose from the following output
targets: Browser, Repository and Mail. You can also specify the render details, including page
size and orientation (portrait or landscape).

•

Show filter button: A filter button will display. On clicking, a filter editor will open.

•

Show maximise button: A maximise button will display allowing you to maximise or restore the
component in the browser.

•

URL: On selecting the Source, the related URL will automatically appear.

•

Source: Select from universe, view or embedded. A window will pop up, showing the available
tables under universe, or the available views under the view options, with an option to use all data
from that view or only the selected items, or display the schema under the embedded option.

•

Parameters: After the Source and URL are set, parameters will display (if any).

•

Javascript: Enter any Javascript code that needs to be run.

•

Add: In the Add Filter window, you can specify the field name, filter type and condition, as
well as edit or delete the views. Refer to Table 7.1, “Filter Types”.

Data

Filter
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Table 7.1. Filter Types
Filter Type

Description

less-than

This will show the records which are less than the value in the Condition field.

more-than

This will show the records which are more than the value in the Condition field.

equal

This will show the records which are equal to the value in the Condition field.

equal-null

This will not show any records.

not-less-than

This will show the records which are not less than the value in the Condition
field.

not-more-than

This will show the records which are not more than the value in the Condition
field.

not-equal

This will show the records which are not equal to the value in the Condition field.

not-equal-null

This will show all the records which are not null records.

less-than-or-equal

This will show the records which are less than or equal to the value in the
Condition field.

more-than-or-equal This will show the records which are more than or equal to the value in the
Condition field.
in-dataset

Click the checkbox next to the Condition field. Select a view and column, or a
universe and a table. After you make your selection, the filter condition details
will automatically display in the Condition field. Click OK and click Apply.
Records in the dataset will display.

not-in-dataset

Click the checkbox next to the Condition field. Select a view and column, or a
universe and a table. After you make your selection, the filter condition details
will automatically display in the Condition field. Click OK and click Apply.
Records not in the dataset will display.

is-true

Records that match the filter condition specified in the Condition field, will
display.

is-false

Records that do NOT match the filter condition specified in the Condition field,
will display.

Area Chart

Area charts are used to represent cumulated totals using numbers or percentages, over time. Use the
area chart for showing trends over time among related attributes.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
ElxArea
•

Data: Specifies the data sort order - either Ascending or Descending. In addition, the parameters
for the Key and X and Y values can be selected. The Y value can be of various functions.

•

General Properties: Allows you to set the padding, the speed of the animation and the palette
colours.
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•

Background: Allows you to set the background properties such as border colour, width, radius
and opacity.

•

Title: Enter a title for the chart and set its various properties such as position, alignment, rotation,
padding and gap.

•

Subtitle: Enter a subtitle for the chart and set its various properties such as position, alignment,
rotation, padding and gap, for each of the four directions - North, South, East and West.

•

Legend: Set the legend and its properties.

•

Tooltip: Set whether to hide or show tool tips. In addition, set the properties of the tool tip such
as the font and background border colour and opacity.

•

Horizontal Axis: Set the properties of the horizontal axis such as padding, gap, and the format
and font for the labels.

•

Vertical Axis: Set the properties of the vertical axis such as padding, gap, and the format and font
for the labels.

•

Stripe: Set whether to hide or show stripes. In addition, set the properties of the stripe such as the
font and background border colour and opacity.

•

Area: Set the properties of the chart area such as the opacity and border width.

•

Point: Set the properties of points such as the font, radius and opacity.

Filter: See the section called “Filter”

Bar Chart

A bar chart uses either horizontal or vertical bars to show comparisons among categories. One axis of
the chart shows the specific categories being compared, and the other axis represents a discrete value.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
ElxBar
•

Data: Specifies the data sort order - either Ascending or Descending. In addition, the parameters
for the Key and X and Y values can be selected. The Y value can be of various functions.

•

General Properties: Allows you to set the padding, the speed of the animation and the palette
colours.

•

Background: Allows you to set the background properties such as border colour, width, radius
and opacity.

•

Title: Enter a title for the chart and set its various properties such as position, alignment, rotation,
padding and gap.

•

Subtitle: Enter a subtitle for the chart and set its various properties such as position, alignment,
rotation, padding and gap, for each of the four directions - North, South, East and West.
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•

Legend: Set the legend and its properties.

•

Tooltip: Set whether to hide or show tool tips. In addition, set the properties of the tool tip such
as the font and background border colour and opacity.

•

Horizontal Axis: Set the properties of the horizontal axis such as padding, gap, and the format
and font for the labels.

•

Vertical Axis: Set the properties of the vertical axis such as padding, gap, and the format and font
for the labels.

•

Stripe: Set whether to hide or show stripes. In addition, set the properties of the stripe such as the
font and background border colour and opacity.

•

Area: Set the properties of the chart area such as the opacity and border width.

•

Point: Set the properties of points such as the font, radius and opacity.

Filter: See the section called “Filter”

Column Chart

A column chart is a graphical representation of data with rectangular bars of lengths that are proportional
to the magnitudes or frequencies of what each bar signifies. It is used to show a difference over a period
of time or even illustrate a comparison between items. It is similar to a bar chart but with the bars
plotted vertically.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
ElxColumn
•

Data: Specifies the data sort order - either Ascending or Descending. In addition, the parameters
for the Key and X and Y values can be selected. The Y value can be of various functions.

•

General Properties: Allows you to set the padding, the speed of the animation and the palette
colours.

•

Background: Allows you to set the background properties such as border colour, width, radius
and opacity.

•

Title: Enter a title for the chart and set its various properties such as position, alignment, rotation,
padding and gap.

•

Subtitle: Enter a subtitle for the chart and set its various properties such as position, alignment,
rotation, padding and gap, for each of the four directions - North, South, East and West.

•

Legend: Set the legend and its properties.

•

Tooltip: Set whether to hide or show tool tips. In addition, set the properties of the tool tip such
as the font and background border colour and opacity.

•

Horizontal Axis: Set the properties of the horizontal axis such as padding, gap, and the format
and font for the labels.
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•

Vertical Axis: Set the properties of the vertical axis such as padding, gap, and the format and font
for the labels.

•

Stripe: Set whether to hide or show stripes. In addition, set the properties of the stripe such as the
font and background border colour and opacity.

•

Area: Set the properties of the chart area such as the opacity and border width.

•

Point: Set the properties of points such as the font, radius and opacity.

Filter: See the section called “Filter”

Line Chart

A line chart displays information as a series of data points called 'markers' connected by straight line
segments. A line chart is usually used to visualise a trend in data over intervals of time – a time series
– thus the line is often drawn chronologically.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
ElxLine
•

Data: Specifies the data sort order - either Ascending or Descending. In addition, the parameters
for the Key and X and Y values can be selected. The Y value can be of various functions.

•

General Properties: Allows you to set the padding, the speed of the animation and the palette
colours.

•

Background: Allows you to set the background properties such as border colour, width, radius
and opacity.

•

Title: Enter a title for the chart and set its various properties such as position, alignment, rotation,
padding and gap.

•

Subtitle: Enter a subtitle for the chart and set its various properties such as position, alignment,
rotation, padding and gap, for each of the four directions - North, South, East and West.

•

Legend: Set the legend and its properties.

•

Tooltip: Set whether to hide or show tool tips. In addition, set the properties of the tool tip such
as the font and background border colour and opacity.

•

Horizontal Axis: Set the properties of the horizontal axis such as padding, gap, and the format
and font for the labels.

•

Vertical Axis: Set the properties of the vertical axis such as padding, gap, and the format and font
for the labels.

•

Stripe: Set whether to hide or show stripes. In addition, set the properties of the stripe such as the
font and background border colour and opacity.

•

Area: Set the properties of the chart area such as the opacity and border width.
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•

Point: Set the properties of points such as the font, radius and opacity.

Filter: See the section called “Filter”

Pie Chart

A pie chart is a circular chart divided into sectors, each depicting a numerical proportion. In a pie chart,
the arc length of each sector, is proportional to the quantity it represents.
Pie charts are generally used to show percentage or proportional data and usually the percentage
represented by each category is provided next to the corresponding slice of pie.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
ElxPie
•

Data: Specifies the data sort order - either Ascending or Descending. In addition, the parameters
for the Key and X and Y values can be selected. The Y value can be of various functions.

•

General Properties: Allows you to set the padding, the speed of the animation and the palette
colours.

•

Background: Allows you to set the background properties such as border colour, width, radius
and opacity.

•

Title: Enter a title for the chart and set its various properties such as position, alignment, rotation,
padding and gap.

•

Subtitle: Enter a subtitle for the chart and set its various properties such as position, alignment,
rotation, padding and gap, for each of the four directions - North, South, East and West.

•

Legend: Set the legend and its properties.

•

Tooltip: Set whether to hide or show tool tips. In addition, set the properties of the tool tip such
as the font and background border colour and opacity.

•

Horizontal Axis: Set the properties of the horizontal axis such as padding, gap, and the format
and font for the labels.

•

Vertical Axis: Set the properties of the vertical axis such as padding, gap, and the format and font
for the labels.

•

Stripe: Set whether to hide or show stripes. In addition, set the properties of the stripe such as the
font and background border colour and opacity.

•

Area: Set the properties of the chart area such as the opacity and border width.

•

Point: Set the properties of points such as the font, radius and opacity.

Filter: See the section called “Filter”
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Scatter Chart

A scatter uses Cartesian coordinates to display values for two variables for a set of data. The data is
displayed as a collection of points, each having the value of one variable determining the position on
the horizontal axis and the value of the other variable determining the position on the vertical axis.
A scatter chart is used when a variable exists that is below the control of the experimenter. If a parameter
exists that is systematically incremented and/or decremented by the other, it is called the control
parameter or independent variable and is customarily plotted along the horizontal axis. The measured
or dependent variable is customarily plotted along the vertical axis.
The scatter chart can suggest various kinds of correlations between variables with a certain confidence
interval.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
ElxScatter
•

Data: Specifies the data sort order - either Ascending or Descending. In addition, the parameters
for the Key and X, Y and R values can be selected. The X, Y and R values can be of various
functions.

•

General Properties: Allows you to set the padding, the speed of the animation and the palette
colours.

•

Background: Allows you to set the background properties such as border colour, width, radius
and opacity.

•

Title: Enter a title for the chart and set its various properties such as position, alignment, rotation,
padding and gap.

•

Subtitle: Enter a subtitle for the chart and set its various properties such as position, alignment,
rotation, padding and gap, for each of the four directions - North, South, East and West.

•

Legend: Set the legend and its properties.

•

Tooltip: Set whether to hide or show tool tips. In addition, set the properties of the tool tip such
as the font and background border colour and opacity.

•

Horizontal Axis: Set the properties of the horizontal axis such as padding, gap, and the format
and font for the labels.

•

Vertical Axis: Set the properties of the vertical axis such as padding, gap, and the format and font
for the labels.

•

Stripe: Set whether to hide or show stripes. In addition, set the properties of the stripe such as the
font and background border colour and opacity.

•

Area: Set the properties of the chart area such as the opacity and border width.

•

Point: Set the properties of points such as the font, radius and opacity.
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Filter: See the section called “Filter”

Data
Common Properties
This section lists the properties that are common to the Data components.

View
The View tab lets you see the views name and type and also set the initial visibility and z-index.
The Image Server provides a static image of your view.
The Show Image Server Url option allows you to set the image height and width, and the cache
duration.
You can copy and paste this URL anywhere else (for example, in Adhoc Reports) to display the image.

Action Bar
•

Show action bar: Determines whether to display the action bar or not.

•

Title: Fill in the title.

•

Show info button: Fill in the information and customise its format. On clicking, the information
you have entered will display in a text field, guiding the user on how to proceed.

•

Show render button: A render button will display, which allows you to render into the desired
output format, including HTML, PDF, XLSX and CSV. You can choose from the following output
targets: Browser, Repository and Mail. You can also specify the render details, including page
size and orientation (portrait or landscape).

•

Show filter button: A filter button will display. On clicking, a filter editor will open.

•

Show maximise button: A maximise button will display allowing you to maximise or restore the
component in the browser.

•

URL: On selecting the Source, the related URL will automatically appear.

•

Source: Select from universe, view or embedded. A window will pop up, showing the available
tables under universe, or the available views under the view options, with an option to use all data
from that view or only the selected items, or display the schema under the embedded option.

•

Parameters: After the Source and URL are set, parameters will display (if any).

•

Add: In the Add Filter window, you can specify the field name, filter type and condition, as
well as edit or delete the views. Refer to Table 7.1, “Filter Types”.

Data

Filter

Adhoc Report
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Adhoc Report displays reports with file extension .report.
Adhocreport
View: See the section called “View”
•

URL: Click Repository to select the repository that contains the data for the report.

Scriptable

Allows the dashboard designer to write custom HTML and Javacript code to completely control the
visual aspects of the view.
Scriptable can be used to develop quick simple solutions that the current set of dashboard views cannot
yet handle.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
Scriptable
•

Use Data Array When checked, the system treats the data received as a Javascript array of arrays.
Else, the system treats the data received as a Javascript array of objects.

•

HTML/Javascript: Enter your custom HTML or Javascript code here.
Ensure that you use the special div element
<div class='elx-datahtml-script'></div>
and write any required html elements above that.
To access the data from the parent element, use code as shown in the following sample:

var parent = $("#"+viewId).;
var data = parent.data("data");

Filter: See the section called “Filter”

Data Label

Allows you to display a custom label containing the result of a statistical operation such as Sum,
Average or Count of the data in the selected table.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
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Data: See the section called “Data”
Datalabel
•

Value and Label: Select the column and the statistical operation. Customize the label text as
desired. An example is shown in Figure 7.3, “Datalabel Example”.

Figure 7.3. Datalabel Example

•

Result Format: Format for displaying the result. For example, selecting 0.00 as the format, will
cause all numbers to be displayed with two decimal points

Filter: See the section called “Filter”

Datepicker

Datepicker is used for date fields and allows you to either type in a date or select it from a drop down
calendar.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
Type
•

•

Type:
•

single: This displays a single date.

•

range: This displays a range of dates.

Label1: The label is customisable. The default label name is From. If you want to display a single
date, only Label1 is necessary.
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•

Label2: The label is customisable. The default label name is To. If you want to display a date
range, both Label1 and Label2 are necessary.

•

Mode:
•

datetime picker: Allows you to select a date and a time.
For example, you can use this mode to filter data to show records pertaining only to 23/08/2004
at 9:00 pm.

•

time picker: This displays a calendar combo box and a slider with hours, minutes and seconds
for you to choose the exact time.

•

date picker: This displays a calendar combo box for you to choose the date.

•

month picker: This displays two drop-down lists with months and years for you to choose the
month.

•

year picker: This displays a drop-down list with years for your selection.

•

Column: Specify a column from which the Datepicker will read data.

•

Date Format: Select a date format. Some date formats are as follows:
•

yy-mm-dd: e.g. 2012-06-01

•

D, dd M y: e.g. Fri, 01 Jun 12

•

D, d M y: e.g. Fri, 1 Jun 12

•

DD, dd-M-y: e.g. Friday, 01-Jun-12

•

D, d M yy: e.g. Fri, 1 Jun 2012

Selection:
•

Value: One of Fixed or Relative. You can select a fixed date when set to fixed. When set to relative,
the selection you make is relative to the current date.
For example, if you set the relative date as 1 month, and the current date is 25 March 2015, the
actual date that the date picker refers to is 24 April 2015.

Filter: See the section called “Filter”

Grid

Grid view shows unique values from a particular column in the universe. A grid is a selection mechanism
to narrow down the range of values, and is used to view a summary of the data.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
Type
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•

Single Select / Multiple Select: Set whether the user can have single selection or multiple selections
in the Run mode.

•

Enable Select All: Allows you to select all entities at once.
This is only available in multi select mode and for checkbox and grid.

•

Type: Select from the following options.
•

Grid: Display the grid directly.

•

Select: Display the grid as a drop down list.

•

Checkbox: Display the grid as check boxes.

•

Radio: Display the grid as radio buttons.

•

Count: Set the number of rows or columns in the grid.

•

Direction: Select from the following options.
•

Down: Display the grid using the down then across direction.

•

Across: Display the grid using the across then down direction.

•

Sort: Sorts the data for the grid in either Ascending or Descending order. Set it to none to omit
sorting.

•

Sort Column:The column to sort on.

•

Format: Format for display. For example, selecting 0.00 as the format, will cause all numbers
to be displayed with two decimal points.

•

Column: Select the column from where the grid will read data.

•

Use Enumeration Values: Specify the values to be enumerated.
This is only available if enumerations have been defined in the Universe for the column you want
to use in the Grid.

The following screen shots illustrate how the grid displays with differing counts and directions. The
data for the grid is taken from the universe named US State.
Grid with Count set as 2 (Grid with two rows) and direction set as Down:

Figure 7.4. Grid With Count Set as 2 and Direction Set as Down

Grid with Count set as 2 (Grid with two columns) and direction set as Across:
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Figure 7.5. Grid With Count Set as 2 and Direction Set as Across

Grid with Count set as 3 (Grid with three rows) and direction set as Down:

Figure 7.6. Grid With Count Set as 3 and Direction Set as Down

Grid with Count set as 3 (Grid with three columns) and direction set as Across:

Figure 7.7. Grid With Count Set as 3 and Direction Set as Across

Selection: Specifies whether the first value or all values in the grid should be selected by default.
Filter: See the section called “Filter”

Parameter

This component allows you to submit parameter values that can be used by many different views, to
the dashboard.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Type
•

Show Submit Button: Selecting this option allows you to submit parameter values to the dashboard,
which in turn can be used by different views. For example, a Report view may require a parameter
to display a report, and this parameter can be supplied at run time via the Parameter view. This
option enables all form elements to be submitted together as otherwise submission is automatic
on a per form element basis. For example, clicking Enter in the text field will submit only the text
field.
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•

Parameters: A list of parameters (if any) will show in the Parameter list. These parameters are
required by various dashboards to show their content. The designer can choose some parameters
or all of them to be presented as form elements on the form.

Report

Report displays RML reports.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Type
•

RML: Click Choose from repository... to set the RML file path, or type the path manually in the
RML field.

•

Scrolling: If this option is selected, horizontal and vertical scroll bars will automatically display
around the report view if they are required.

•

Paged: If this option is selected, there will be a page navigator when the report is broken into
pages.

•

Streamed: If this option is selected, the report will be one continuous page. This is the opposite
of the Paged option.

•

Parameters: Parameters will get loaded automatically (if any).

Report List

Report List allows a collection of RML reports specified by tags to be listed, previewed and rendered.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Type
•

Heading: Type the heading for each report.

•

Tags: Type the tag for each report.

•

Show Preview: Enable you to preview the report in the design process.

•

Output: You have the option to render the report list into the following formats: PDF, DOCX,
CSV, EXCEL, and PRINT.

•

Report: On clicking Refresh Reports, parameters and values will be automatically loaded (if
any).
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Search

Allows the user to enter search criteria to determine what data is considered selected. The results of
the search operation cannot be seen in the search view, but can only be seen by using the search as a
data-source for another view. Therefore, by changing the search criteria in the search view, what is
displayed in the other view will change.
View: See the section called “View”
Data: See the section called “Data”
Type
•

Show header: Select to show the column headers in search results.

•

Select all on no criteria: Selects all the records in the database if you do not specify the search
criteria.

•

Autocomplete Limit: The autocomplete limit allows the number of suggestions in the auto
complete list to be capped.

•

Column and Alias Columns allow the dashboard designer to select which fields will participate
in the available search criteria. Alias allows you to rename them to your desired names for display.

Slider

Slider is used to select a value from a range of values that is displayed. The range can be a numerical
range or a date range.
View: See the section called “View”
Actionbar: See the section called “Action Bar”
Data: See the section called “Data”
Type
•

Persist Selection: The selection remains permanent until the user un-selects the selection.
See the section called “Table” for more information.

•

Type:
•

date: Select this option to read data from a date column. Between the two ends of the Slider,
the dates will display individually.

•

date-range: Select this option to read data from a date column. Between the two ends of the
Slider, the dates will display as a range.

•

numerical: Select this option to read data from a numerical column. Between the two ends of
the Slider, numericals will display individually.

•

numerical-range: Select this option to read data from a numerical column. Between the two
ends of the Slider, numbers will display as a range.
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•

Horizontal / Vertical: Select the direction of the Slider.

•

Update on Stop / Update on Slide: Indicates when to update the related views that are filtered
by the slider.
If Update on Stop is selected, the views are updated, after you stop dragging the slider.
If Update on Slide is selected, the views are updated, in real time as you drag the slider. This
is a very resource intensive operation, as the update requests need to be sent in real time to the
server, as you drag the slider.

•

Label: Create a label name for the Slider.

•

Wrap Label Text: If this option is selected, the label text will automatically wrap. Otherwise, the
label text will not wrap but overlap.

•

Label Step: Set the label step for the Slider. For example, if the step equals to 1, there will be a
label for every value. If the step equals to 3, there will be a label for every three values.

•

Show Tooltips: If this option is selected, a component tip will display when a label is selected.

•

Format: The data format to use for display. For example, selecting the data format as 0.00 will
cause all numbers to be displayed with two decimal places.

•

Column: Select a column from which the Slider will read data. The data type in the column must
be consistent with the type of the Slider. For example, if you choose Slider - Type - Date, it is
necessary to choose a column which contains date values.

•

Use Enumeration Values: Specify the values to be enumerated.
This is only available if enumerations have been defined in the Universe for the column you want
to use.

•

Date Format: Select one of the following date formats.
•

yy-mm-dd: e.g. 2012-06-01

•

D, dd M y: e.g. Fri, 01 Jun 12

•

D, d M y: e.g. Fri, 1 Jun 12

•

DD, dd-M-y: e.g. Friday, 01-Jun-12

•

D, d M yy: e.g. Fri, 1 Jun 2012

Selection
•

None: Do not select any values in the slider.

•

All: Select all the values by default in the slider.

•

First: Select the first value by default in the slider.

Filter: See the section called “Filter”.

Table
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This displays the data in a tabular form.
View: See the section called “View”
Actionbar: See the section called “Action Bar”.
Data: See the section called “Data”
Type
•

Persist Selection: The selection remains permanent until the user un-selects the selection.

Consider three tables A - B - C, each with a single column named id with four rows 1,2,3,4.
Initially, if table A has four rows of data, and the first two are selected (1,2), then table
B will show two rows (1,2), and table C will show no rows as there are no selections on
table B.
If now we select the first row in table B, then table C will show one selection (1). If we
now go back to table A, and unselect row (2), what happens in table B depends on the
option "Persist Selection".
If Persist Selection is unchecked, then any changes on A will clear all selections in B. If
Persist Selection is checked, then any changes on A will clear some or maybe all of the
selection in B.
If we unselect row (2) in table A, with Persist Selection unchecked, then table B and table
C will show no data.
If we unselect row (2) in table A, with Persist Selection checked, then table B will show
one row (1) selected and table C will show one row.
•

Page Size: Set the maximum number of columns that will display on one page.

•

Enable Caching: Specifies that the pages of the table are to be cached, for increased performance.

•

Layout: One of Auto or Fxed. Auto allows Ambience to manage the width of the table automatically. Fixed creates a fixed width table.

•

Single Select / Multiple Select: Set whether the user can have single selection or multiple selections
in the Run mode.

•

Enable Select All: Allows you to select all entities at once.
This is only available in multi select mode and for checkbox and grid.

•

Selection Checkboxes: If this option is enabled, you can either select Left Column or Right Column
from the Checkbox Location option, to display the checkboxes at the left or right side of
table columns.

•

Cell Minimum Width: Denotes the minimum width (in pixels) to reserve for each cell.

•

Show Cell Tooltip: Specifies whether to show the tooltip, if any, for each cell.

•

Enable Hyperlinks: Treats any URL in the table content as a hyperlink.

•

Defaults: Specifies the default text that is displayed for Empty Strings, Infinity, NaN and when
there is no data in the table.
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•

Choose columns: After the Data - Source is set, columns under that source will automatically
display. Click Choose columns, and the Column Chooser window will display. Make your selections
and click OK.

Alias Indicates an alternative name for the column, for display.
Format The data format to use for the column For example, selecting the data format as 0.00
will cause all numbers in that column to be displayed with two decimal places.
Alignment indicates the text alignment for the column - either left, right or center justified.
Text Overflow determines how to handle text that overflows the width of the table. Either you
can set it to nowrap which will allow the text to overflow into the next column, or wrap which
causes a line break and allows the text to be displayed on multiple lines.
Width indicates the width of each column, in pixels. A value of zero causes the width to be
automatically determined. Else, the width of the column is set to the user defined value.
Hyperlink Text allows you to hyperlink the column header.
Sortable makes the column sortable. Double click the column header to sort the column in
Ascending order. Double click the column header again to sort the column in Descending order.
Allow Render indicates whether the output of the column is to be included when rendering to PDF
and HTML. Select this option as desired.
Renderers: The renderers column allows the contents of the table cell to be displayed or
rendered differently depending on the value in the cell.
An expression is selected to test the value. If the expression is true, the cell can be changed by one
or more of the following ways.
•

Background colour

•

Foreground colour

•

Add an icon

This allows you to mark a cell or a row of cells with unusually high values, for instance.

One or more tests can be added per column. The first test that evaluates to true is the one
that is used to render the cell.
(From Ambience 3.6)Expressions: You can now add custom Javascript code to transform your data
as you wish, for display.
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In the Javascript code, a single substitution - #{value} is required. This represents the cell value
that is used as input to the expression.
For example, the following Javascript code in a Date column will transform the date into an age.

function getAge(dateStr) {
var split = dateStr.split("-");
var dob = new Date(split[0], split[1], split[2]);
var now = new Date();
var age = now.getFullYear() - dob.getFullYear();
var m = now.getMonth() - dob.getMonth();
if (m < 0 || (m === 0 && now.getDate() < dob.getDate())) {
age = age - 1;
}
var r = age.toString();
var n = r.split(".");
return n[0];
}
return getAge(#{value});
The result of this expression will be the age (calculated as the difference between the current date and
the date mentioned in the input.)
The TableView cell expression allows expressions to be calculated based on values of other columns
of the same table row.
If a table has a schema of:

[Fruit100.Company, Fruit100.WeightKG, Fruit100.Unit Cost,
Fruit100.Quantity, Fruit100.Id, Fruit100.Date]

To access the value of a column, you wrap the column with #. For example:

#{Fruit100.Company}

Here is an example expression:

function test(company) {
if (company === "C") {
if (#{Fruit100.WeightKG}
<= 1.2)
{ return "C Weight <= 1.2"; }
else
{ return "C Weight 1.2"; }
}else
{ return company; }
}
return test(#
{value}
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);
Filter: See the section called “Filter”

General
Common Properties
This section lists the properties that are common to the General components.

View
The View tab lets you see the views name and type and also set the initial visibility and z-index.
The Image Server provides a static image of your view.
The Show Image Server Url option allows you to set the image height and width, and the cache
duration.
You can copy and paste this URL anywhere else (for example, in Adhoc Reports) to display the image.

Blank

This component can be used as a place holder. You could use it to fill a space on the dashboard while
waiting for a new View to be created.
After you add a Blank component, a blank area will display. Double-click the blank area to alter the
properties.
View: See the section called “View”

Button

Adds a push button to your dashboard.
After you add a Button component, a component area with an image icon will display. Double-click
the component area to alter the properties. You can specify the images that indicate the static, hover
and active states.
View: See the section called “View”
Type
•

Image: Choose from a repository and set an image for the button.

•

Hover: Choose from a repository and set an image that displays when the cursor is hovering over
the button.

•

Active: Choose from a repository and set an image that displays when the button is activated.
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Cardnav

A Dashboard is built from Cards and Views. To navigate between cards, you use the CardNav view.
The other method to navigate between cards is to use the Show Card action.
This is the card navigation component. After you add a Cardnav component, a component area with
buttons will display. Double-click the component area to alter the properties.
View: See the section called “View”
Type
•

Choose cards...: You can choose cards for navigation. In the Run mode, there will be buttons that
link to the chosen cards on clicking.

•

Fixed Width: If selected, buttons are all of the same width. If not selected, the button width depends
on text width count and direction, allowing control over layout.

•

Count: Sets the number of rows or columns of the grid.

•

Direction: Select from the following options.
•

Down: Display the grid using the down then across direction.

•

Across: Display the grid using the across then down direction.

For more information on count and direction, see the section called “Grid”.

Freetext

You can use this component to create a multi line label embedded with images and your own desired
formatting, using the provided rich text editor.
After you add a Freetext component, a component area showing “Default Freetext” will display.
Double-click the component area to alter the properties.
View: See the section called “View”
Type
•

Text: Enter any text using the embedded text editor.

Glint

Glint is Elixir's native vector graphics format. This component displays Glint reports.
View: See the section called “View”
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Glint
•

URL: Enter the URL of the Glint report into the field. The URL can be either a path in the repository, or a URL on the Internet.

HTML

This is used to display the HTML content from a URL.
After you add a HTML component, a blank area will display. Double-click the area to alter the
properties.
View: See the section called “View”
Type
•

URL: Enter the URL of the HTML page into the field. The URL can be either a path in the
repository, or a URL on the Internet.

•

Choose from repository...: You can choose a HTML file from the repository to display in the
view.

•

Scrolling: If this option is selected, horizontal and vertical scroll bars will automatically display
around the HTML view if they are required.

Image

This component is used to display an image.
After you add an Image component, a component area with an image icon will display. Double-click
the component area to alter the properties.
View: See the section called “View”
Type
•

URL: Enter the URL of the image into the field. The URL can be either a path in the repository,
or a URL on the Internet.

•

Choose from repository...: You can choose an image from the repository to display in the view.

•

Tooltip: Enter the tooltip to display when hovering over the image.

•

Hyperlink: Specifies a hyperlink for the image. Clicking the image, opens the hyperlink.

•

Target: Specifies how to open the hyperlink. Choosing Self opens the hyperlink in the current
window. Choosing Blank opens it in a new window.

Label
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Displays a single line label that you can enter using the text editor.
After you add a Label component, a component area showing “Default Label” will display. Doubleclick the component area to alter the properties.
View: See the section called “View”
•

Text: Enter the text into the text editor, and set the format, which will display as the label.

Rectangle

This component draws a rectangle on the dashboard.
You can use this component to group views together on the same card by using a Rectangle view as
a background, for example.
In addition, you can display SVG graphics using this component.
After you add a Rectangle component, a component area in a rectangular shape will display. Doubleclick the component area to alter the properties.
View: See the section called “View”
Type
•

Gradient Type: Set a blend of two colours to fill up the rectangle.
•

none: There will not be any gradient effect and only one colour will be used.

•

horizontal: The direction of the gradient will be from left to right.

•

vertical: The direction of the gradient will be from top to bottom.

•

forward diagonal: The direction of the the gradient will be along the forward diagonal line.

•

backward diagonal: The direction of the gradient will be along the backward diagonal line.

•

Fill Colour: Specify the fill colour with which to start.

•

Fill Colour 2: Specify the fill colour with which to end.

•

Border: Tick if you need a border around the rectangle.

•

Border Width: Select a width from the drop down list.

•

Border Radius: Select a radius from the drop down list to add a rounded border.

•

Border Colour: Specify the border colour.

•

Use SVG: Tick if you want to use SVG markup, and the other options related to rectangle will be
automatically disabled. Deselecting this option means you use the rectangle mode, in which you
set the options to create a SVG rectangle for creating simple backgrounds of views.

•

SVG: Enter the SVG markup into this field to bring you more control to create more sophisticated
designs.
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Adding Annotations
From Ambience 3.6 onwards, you can add annotations to your dashboard.
Annotations allow you to add comments to the various items on your running dashboard. They help
you enrich the dashboard experience by adding value to the information that your dashboard presents
to your users.

Adding an Annotation
To add an annotation:
1.

Click the Dashboard Properties icon (

2.

Activate the Enable Annotations option as show in Figure 8.1, “Enable Annotations”.

)

Figure 8.1. Enable Annotations

3.

Create your dashboard.

4.

Click Run to run your dashboard. The Annotations button is visible in the center as shown in
Figure 8.2, “Annotations Button”.
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Figure 8.2. Annotations Button

5.

Click the Annotations button. Select the Show and Edit options as shown in Figure 8.3, “Show
and Edit Options”.

Figure 8.3. Show and Edit Options

The Show option displays the existing annotations. The Edit option allows you to add and edit
annotations. It displays two tools for adding annotations.
You can either create a Point annotation that annotates one particular point on the dashboard or
a Block annotation that annotates a larger area of the dashboard.

Adding a Point Annotation
1.

To create a point annotation, drag the point annotation tool ( ) to the point on your dashboard
that you wish to annotate. This is shown in Figure 8.4, “Create a Point Annotation”.
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Figure 8.4. Create a Point Annotation

2.

To edit the annotation text, click the Edit icon (
in Figure 8.5, “Edit the Point Annotation Text”.

). Then, edit the text as in the example shown

Figure 8.5. Edit the Point Annotation Text

3.

Click the Save icon ( ) to save the changes.

Adding a Block Annotation
1.

To create a block annotation, drag the block annotation tool ( ) to the area on your dashboard
that you wish to annotate. This is shown in Figure 8.6, “Create a Block Annotation”.
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Figure 8.6. Create a Block Annotation

2.

To edit the annotation text, click the Edit icon ( ). Then, edit the text as in the example shown
in Figure 8.7, “Edit the Block Annotation Text”.

Figure 8.7. Edit the Block Annotation Text

You can edit an annotation only if you are its owner.
3.

Click the Save icon ( ) to save the changes.

Viewing the List of Annotations
To view the list of annotations:
1.

Click the Show option.

2.

Select an annotation from the annotation selector as shown in Figure 8.8, “Selecting an
Annotation”.

Figure 8.8. Selecting an Annotation
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3.

Click the annotation to view it on the dashboard.

Moving an Annotation
Drag the annotation on the dashboard to the new location.

Anyone can move annotations around in run or edit mode but not the rectangle or pointer that
remains fixed. Moving allows them to be moved out the way if they are blocking something.
However the new position is not saved, and is temporary. Only the creator of the annotation
can move them and their new position will be saved permanently.

Adding an Annotation Comment
To add an annotation comment:
1.

Click the Add (

) icon from the Annotation Comments section.

2.

Enter the annotation comment.

3.

Click the Save icon ( ) to save the changes.

Deleting an Annotation Comment
To delete an annotation comment:
1.

Click the Edit option.

2.

Click the Delete (

) icon for the annotation comment that you want to delete.

•

You can only delete your own annotation comment. Only an administrator can delete
all annotation comments.

•

An annotation contains one or more comments but you can only delete the last
comment if you have the rights to do so. This means if an annotation has three
comments, in order to delete comment two, you first have to delete comment three
which is the last comment. To delete the entire annotation, you need to delete all
comments and this is equal to deleting comment number one.
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Adding a Dashboard Header and
Footer
You can add a fixed dashboard header and footer that does not scroll. This is perfect for adding items
that need to be visible at all times - alerts, status messages, menus and login details for example.
To add a dashboard header and footer:
1.

Open the Ambience Designer. From the folder tree, right click the Resources entry and click Add
> Folder. Name the new folder as CSS. This is shown in Figure 9.1, “Add CSS Folder”.

Figure 9.1. Add CSS Folder

2.

Right click the CSS folder, and select Add > CSS. Enter a name for the CSS file. For example,
DashboardHeaderAndFooter.css. This is shown in Figure 9.2, “Add CSS File”.
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Figure 9.2. Add CSS File

3.

In the text editor workspace, add in the CSS code. For example:

#dashboard-header
{ background: red; color: white; height: 40px; }
#dashboard-footer
{ background: grey; color: black; height: 30px; }
This is shown in This is shown in Figure 9.3, “Add CSS Code”.

Figure 9.3. Add CSS Code

4.

Save your CSS file.

5.

Open your browser and navigate to your dashboard.
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6.

Click the dashboard includes icon ( ).

7.

Click the CSS tab, and click Add.

8.

Click Repository and select your CSS code file as shown in Figure 9.4, “Select CSS File”.

Figure 9.4. Select CSS File

9.

Click OK.

10. From the Dashboard Includes screen, click OK.
11. Refresh your browser and you will see your dashboard header and footer as shown in Figure 9.5,
“Dashboard Header and Footer”.

Figure 9.5. Dashboard Header and Footer
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